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About this Learner Resource

The purpose of this Learner Resource is to provide you with the under-

pinning knowledge required to assist you in completing assessment/s in 

Produce spreadsheets. 

This Learner Resource also contains activities for you to test your knowl-

edge and examples of skills application. 

Throughout this Learner Resource, you will see an icon  that provides 

opportunities to test your knowledge and practice skills. This icon is 

displayed as follows: 

Practice

This icon is used to highlight an ideal time to test your knowledge or 

practice what you have learnt.

How will I be assessed?

In order to achieve competency in Produce spreadsheets you will need 

to demonstrate the skills and knowledge required for the unit.  

Your teacher will decide with you how and when you will be assessed.

Copyright

Parts of this Learner Resource (text and graphics), may have been ob-

tained from other sources and are reproduced within the laws and rights 

of copyright.
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About this unit
Welcome to the Learner Resource for Produce spreadsheets. In this 

Learner Resource you will be learning about the performance outcomes, 
skills and knowledge required to develop spreadsheets through the use of 
spreadsheet software. 

It is suggested that to meet all the requirements of Produce spreadsheets 
you will need to complete the following tasks:

	➤ Read the information contained in this Learner Resource.

	➤ Complete the activities.

	➤ Complete all the required assessment/s for this unit.

The topics in this Learner Resource are:

	➤ Select and prepare resources

	➤ Create simple spreadsheets

	➤ Produce simple charts

	➤ Finalise spreadsheet
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Introduction
	

You  are about to commence a vocation-
al course where you will be required 
to demonstrate your competency in 
developing spreadsheets through 
the use of spreadsheet software. This 
unit of competency covers the skills 
and knowledge required to create 
and design spreadsheets that encom-
pass formatting, formulae and charts, 
working under minimal supervision.
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Select and prepare resources
The first task you will need to consider when producing spreadsheets is 
how to select and prepare the resources you will need to successfully com-
plete the task.

Workplace health and safety issues
The ergonomic requirements of the individual employee is a significant 
workplace health and safety (WHS) issue. As this unit focuses on using the 
computer to create and use spreadsheets, we need to be aware of the de-
sign of the office environment and the individual workstation. 

It is recommended that you consider the following to prevent WHS issues 
when operating computers at workstations within an office environment:

	➤ style of workstation or desk, depending upon the functions to be 
performed

	➤ workstation or desk height

	➤ placement of workstation within the office

	➤ placement of keyboard to align with computer monitor and body, 
mouse and computer monitor, in-out tray, and other equipment 
regularly used

	➤ computer monitor stand, wrist or forearm rests or document hold-
ers, and their placements

	➤ placement of storage facility for items needed to be accessed regu-
larly, such as training manuals, paper, envelopes, pens and so on

	➤ placement of necessary filing cabinets

	➤ adequate leg room underneath workstation or desk

	➤ footrest

	➤ lighting, including optimum lighting for the required task(s), reduc-
tion of glare and reflections from work surfaces
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	➤ noise of nearby equipment or machinery

	➤ provision of privacy and place to talk without interrupting others

	➤ air quality, temperature, including impact from heating/cooling 
vents

	➤ adjustable chair to provide proper support and height

	➤ telephone headset for frequent use

	➤ cabling protection.

Look at the following checklist and answer the questions about your cur-
rent workstation.

Checklist Yes No

Do you have an individual workstation?

Is there enough space around your furniture to gain access to the 
workstation and move around it comfortably?

Is your desk large enough to accommodate all your work?

Is your desk at the correct height?

Is your chair comfortable and able to be adjusted?

Is your computer screen at a comfortable reading distance?

Is the height and angle of your monitor correct?

Is there sufficient space to move your mouse effectively?

Is the keyboard angled correctly?

Do you have to twist your neck to see your work?

Are document holders available?

Can you place your feet on the floor or is there a footrest available?

Is the monitor clean and the image stable?

Does your monitor reflect glare from windows and other objects?

Is the lighting satisfactory, not too bright or too dull?
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Many employees spend most of their day using the computer. It is es-
sential that a correct posture is maintained throughout the day to avoid 
muscle or joint strain. 

Developing touch-typing skills helps to reduce strain in moving the head 
frequently in order to look at the keyboard, particularly when typing from 
a document. 

When typing, you should ensure that your fingers are curved over the 
keyboard with each of your thumbs over the spacebar. Wrists should not 
be raised and elbows should be alongside your body. 

At your workstation, you should exercise frequently to prevent injuries 
from overuse. Be mindful of wrists, arms, shoulders, neck and head, tak-
ing adequate breaks from repetitive tasks, such as using a keyboard and 
mouse.  

Eye strain is also a common problem when working at the computer for 
long periods of time. Look away from the monitor frequently to give your 
eyes a rest. Blinking often will stop your eyes from drying out. 

If ergonomic requirements are not considered, then a worker could suf-
fer all, or any of the following:

	➤ aggravation of an existing 
injury or illness

	➤ neck, shoulder, back, or 
repetitive strain injury

	➤ eye strain or damage.

It is the responsibility of each 
individual to position their com-
puter and keyboard to reduce 
the possibility of workplace injury. 

Tick off the following to ensure that your computer and keyboard are 
correctly positioned.

Poor posture causes pain
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Arrange your work area so that you are directly facing both the computer 
and keyboard. This helps to avoid unnecessary twisting and turning. 

The monitor should be at eye level when sitting. Check to see you are 
looking directly at the top line of the screen. This reduces the chance of 
stressing your neck muscles.

Place monitor at arm’s length away from you to reduce visual fatigue. 

Tilt your screen to reduce glare.

Provide enough workspace for the keyboard, mouse, and other attachments 
so you are able to move about freely without bumping into things.

Adjust your chair so that the keyboard is at elbow level. Your forearms, wrists 
and hands should be in a straight line parallel to the floor as you type

The ergonomics of your workplace 
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You are required to adjust your workspace, furniture and equipment ev-
ery time you use the computer facilities. You will be observed and assessed 
throughout this course on your ability to consistently demonstrate appro-
priate ergonomic practices.

Conservation techniques
Environmentally sustainable work practices are procedures adopted 

within a work environment that contribute to a reduction in the use of the 
earth’s limited resources. It is generally accepted that we must conserve 
and manage these resources for our own needs so that we do not compro-
mise the ability of future generations to meet their needs. 

Some states and countries will have laws that apply to large corpora-
tions. There may also be laws that relate to specific industries which ensure 
that materials are disposed off appropriately. 

Organisations will also have policies and procedures in place to minimise 
wastage. For example, some businesses will have policies for the shredding 
of paper or the correct disposal or recycling of consumables. 

Vodafone Qatar is 
proactive in promot-
ing environmental-
ly sustainable work 
practices.  

Read the follow-
ing advertisement 
to see one way in 
which it is pursuing 
its environmentally 
sustainable ideals.
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What can businesses do to respond to conservation issues?

	➤ Use of email instead of printing and mailing correspondence

	➤ Water conservation

	➤ Paper recycling – prepare note pads from scrap paper`

	➤ Make double sided paper copies where possible

	➤ Shredding of confidential waste paper for recycling

	➤ Turn off mobile phones

	➤ Recycling of printer cartridges

	➤ Use of energy efficient lighting

	➤ Electronic filing and archiving

	➤ Use of power-saving options and stand-by functions on office equip-
ment

	➤ Turning office equipment off at power source when not in use

	➤ Car pooling

Read the following article to see what other procedures Vodafone Qatar 
has implemented in support of its environmentally sustainable work prac-
tices.
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Practice

Practice activity 1

List the practices you believe could be implemented here at school to 
assist with the conservative techniques.
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Task requirements
Often, supervisors will require a task to be completed by the employee. 

However, the supervisor may not provide specific or detailed instructions 
that will enable the employee to complete the task.  

If this is the case, the employee will have to use appropriate questioning 
techniques in order to find out what key information is required to be able 
to perform the task. 

The employee may have to consider who will be the best person to an-
swer their questions. An organisational chart may have to be consulted in 
order to determine the most appropriate person to ask. 

With spreadsheets, we may need to ask specific questions, such as:

	➤ What is the purpose of the spreadsheet?

	➤ What program is to be used?

	➤ What data, numbers or text has to be entered?

	➤ What is the output requirement and what formulae to Create simple 
spreadsheets? 

	➤ Will entering data into a spreadsheet be required?

	➤ How is the data to be presented?

	➤ Will the presentation of charts be necessary?

	➤ How and where will the data be stored?
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Create simple spreadsheets 
Entering data into a spreadsheet

Once you have selected and prepared the resources you need to com-
mence creating your spreadsheet. 

You first need to understand a number of basic concepts associated with 
spreadsheets. 

A spreadsheet is actually a worksheet which is a part of a workbook. If 
you look at the bottom left hand corner of the page you will see that ‘Sheet 
1’ is highlighted. We can use and save any number of sheets, which will 
then form parts of the same workbook. 

You will also see that there are numbers down the left hand column, and 
letters across the top of the page. The numbers on the left, correspond to 
the rows across the page, and the letters at the top correspond to the col-
umns appearing vertically. This is essentially a grid reference system, which 
uses these numbers and letters to determine the exact location of a cell.
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When you open a worksheet, the box at the top left hand corner should 
be clearly highlighted – that is the active cell, and is called ‘A1’ as it appears 
at the junction of the number 1 row and number A column. As you move 
between cells, the highlighted cell is the ‘active’ cell, and its reference ap-
pears in the left hand panel below the toolbar or ribbon.
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Practice

Practice activity 2

Look at the following worksheet.

 What is the location of the active cell?

What is the name of the worksheet?
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You can move between cells by using your mouse, left-click to activate 
a cell, or by using the Tab key. You should note that some manuals will tell 
you to press ‘Enter’ to secure data in the active cell and move to the next, 
and other programs will tell you to record data and then move to the next 
cell by pressing the Tab key. Provided that the correct data appears in the 
cell once you move to the next active cell, it does not matter which method 
you use to enter the data. 

We will now practise working with a spreadsheet. Open excel and create 
a new worksheet and enter the data below. The data consists of both text 
and numbers.
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Spreadsheets consist of rows and columns of numeric data. Mathemati-
cal calculations are performed upon this data. It is therefore most import-
ant that the data entry has to be completely accurate if the results of the 
spreadsheet are to be relied upon.

To enter the numeric data, engage the number lock at the right hand 
side of your keyboard and use the numeric keys in that section or use the 
numeric keys located above the alpha keys in the main section of the key-
board. 

Identify the differences in the following worksheet and make the chang-
es to the spreadsheet you have already created.
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We have seen how important it is to identify the task requirements and 
how you may need to consult an organisational chart to determine who 
the most appropriate person is to assist you with enquiries.  

It is equally important to be aware of the organisational requirements in 
preparing spreadsheets. There may be a number of style and presentation 
requirements you would need to meet in order to satisfy organisational 
procedures. For the purposes of this unit, we will assume the following pro-
cedures should be followed at all times, unless otherwise stated.

1.	 Spreadsheets to be named ‘drive\BSBITU304A\document_title\date’.

2.	 Spreadsheets to be printed showing gridlines and row and column 
headings.

3.	 Always preview your spreadsheet before printing to ensure you do 
not waste paper. Make sure the gridlines and row and column head-
ings are showing.

4.	Print your document but take care to make sure you only print a par-
ticular sheet or selection of a worksheet.

5.	 Save your work using correct 
protocol.

6.	 Amend your spreadsheet 
to correct any data entry or cal-
culation errors.

7.	Save your corrected work or 
‘save as’ a different file name.
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Formatting a spreadsheet using software functions

We are now ready to start creating your first main spreadsheet. The fol-

lowing task requirement is set out as well as all of the data you need.  

Practice

Practice activity 3

You are employed by the stationery division of an organisation, and the 

manager wants you to calculate which of its pen products is the most prof-

itable. The purpose of this spreadsheet is to calculate the net profit re-

ceived for the sale of Super 6 pens over a period of six months. 

Spreadsheet data:

	➤ In January, the division sold 20 pens in the first week, 11 in the sec-

ond week, 7 in the third week and 25 in the last week.

	➤ In February, the numbers were 30 in the first week, 22 in the second 

week, 11 in the third week and 29 in the last week.

	➤ The numbers for March were 28, 19, 8, and 22; for April they were  21, 

10, 6, and 18; for May they were 15, 9, 15, and 18; and for June they 

were 16, 22, 20, and 21.

	➤ Each pen sells for $15 and the cost to the division for acquiring each 

pen is $7.
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Data entry: 

So how do we go about this? Follow the steps in order.

Step 1

Open a new workbook. 

Step 2

In the A1 cell enter ‘Super 6 pens’.

Step 3

In A2 enter the word ‘Month’, in A3 enter ‘Week 1’, in A4 enter ‘Week 2’, in 
A5 enter ‘Week 3’ and in A6 enter ‘Last week’. 

Step 4

In B2 enter January, in C2 enter February, in D2 enter March, in E2 enter 
April, in F2 enter May, and in G2 enter June. 

Step 5

Then you have to enter the number of pens sold.

1 A B C D E F G
2 Month January February March April May June
3 Week 1 20 30 28 21 15 16
4 Week 2 11 22 19 10 9 22
5 Week 3 7 11 8 6 15 20
6 Last Week 25 29 22 18 18 21

Step 6

Now we are going to total the number of pens sold in each month. 
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First, enter the words ‘Month total’ in A7, and then enter the following 
formulae:

	➤ in B7 ‘=B3+B4+B5+B6’ (eg we are directing the program to add the 
amount of pens sold in the first, second, third and last week of Jan-
uary)

	➤ in C7 ‘=C3+C4+C5+C6’

	➤ in D7 ‘=D3+D4+D5+D6’

	➤ in E7 ‘=E3+E4+E5+E6’

	➤ in F7 ‘=F3+F4+F5+F6’

	➤ in G7 ‘=G3+G4+G5+G6’.

All totals for the month should now show as 63, 92, 77, 55, 57 and 79.

Step 7

The next step is to calculate the monthly sales value, at $15 per pen:

In A9 please enter the words ‘Total sale price’, then enter the following 
formulae:

	➤ in B9 enter ‘=B7*15’ (eg we are directing the program to multiply the 
total number of pens sold in January by the sale price of $15)

	� in C9 enter ‘=C7*15’

	� in D9 enter ‘=D7*15’

	� in E9 enter ‘=E7*15’

	� in F9 enter ‘=F7*15’

	� in G9 enter ‘=G7*15’.

The total sale price for each month should now show as 945, 1,380, 1155, 
825, 855 and 1,185. 
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Step 8

Now let’s add the total value of sales for the six months period by in-
serting the words ‘Total sale price for period’ in A11, and then in G11 
entering the formula ‘=B9+C9+D9+E9+F9+G9’ (eg we are directing the 
program to add the value of pens sold for the months of January to June, 
both inclusive). 

The value of the total sales should now be shown as $6,345. 

Step 9

We discover that we have made an error. Before we calculated the value 
of the total sales, we should have calculated the cost of buying the pens 
in order to arrive at a net profit figure. Do we have to do this all over 
again, or is there another way? 

Fortunately, we can use the program to make most calculations, so this 
time we do not need to start from the beginning. 

We know that the purchase price of each pen is $7. So first we need to 
add up the total number of pens for the period in question. 

In A13 insert the words ‘Total number of pens’, and then in E13 insert 
the formula ‘=B7+C7+D7+E7+F7+G7’ (eg we are directing the program 
to add up the total number of pens sold for each month). 

The number shown should be 423.

Then in A14 insert the words ‘Total cost of pens’, and in E14 insert the 
formula ‘=E13*7’ (eg we are directing the program to multiply the total 
number of pens for the period by the purchase price of $7). 

In E14 the total acquisition cost should be shown as $2,961. 

Step 10

So now we know that the total amount the division received for the  Su-
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per 6 pens during the period was $6,345 (G11), and the total costs for 

the Super 6 pens sold in that period was $2,961 (E14). How do we then 

ascertain the net profit? 

In A16 insert the words ‘Net profit for period’, and then in H16 insert the 

formula ‘=G11-E14’ (eg we are directing the program to deduct the total 

cost of the pens for the period as shown in E14, from the total sale price 

of the pens for the period as shown in G11). 

The amount shown in H16 should be $3,384. 

Step 11

Your employer has decided that to calculate the true profit, a percentage 

of 2% should be deducted for handling and freight costs. 

So how do we do this? 

We could multiply the net cost by 2% and then deduct that 2% from the 

total, or we could simply multiply our total by 98% to arrive at the true 

profit figure. 

Therefore, in A18 please insert the words ‘True net profit after deduction 

of 2% handling’, and in I18 insert the formula ‘=H16*98%’ (eg we are di-

recting the program to find 98% of the amount in H16). 

The figure shown should be $3,316.32. 

Step 12

You have now completed Sheet 1 in your workbook. Save that workbook 

by using the designated naming and storing requirements.
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Step 13  

Print Sheet 1, using the designated preview/printing requirements, and 
place your printed work in your portfolio. 

Step 14  

Please turn to Activity answer 3 at the back of this workbook to check 
your spreadsheet and take a rest break.
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Practice

Practice activity 4

Unfortunately, your employer provided you with some incorrect data 
and the spreadsheet previously prepared has to be amended. 

However, just in case he or she decides that the original data was not an 
error, we will decide to be prudent and retain the previously saved spread-
sheet just in case. 

Spreadsheet data 

Week 1 sales for March should be 15, the last week’s sales for May should 
be 22 and June’s sales for week 2 should be 20. 

Data entry 

Retrieve the spreadsheet you have just completed. 

Follow the steps in order to insert your information into another sheet 
and then correct the data. 

Step 1  

With your mouse, using click and drag techniques, highlight all of the 
cells From sheet 1 and including A1 to I18. 

Step 2  

Copy the selection of cells and paste the selection into Sheet 2. 

Step 3  

In D3 change 28 to 15, in F6 change 18 to 22, and in G4 change 22 to 20. 
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You will notice that all of the cells in which formulae have been inserted 

will automatically re-calculate.

Step 4  

However, we have not finished yet. Your employer has decided that the 

handling allowance should be 3% instead of 2%.

Step 5  

Please alter cells A18 and I18 accordingly.

Step 6  

Check that your work is the same as Activity answer 4 at the back of this 

workbook.

Step 7  

Save your work.

Step 8  

Review and print Sheet 2 for inclusion in your portfolio.

Step 9  

Check that you have the original Sheet 1, and your new Sheet 2, in your 

workbook, exit the spreadsheet application and take a rest break.
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Practice

Practice activity 5

You now have to re-name and colour your sheets, and then print them 
using the print option facility.

Spreadsheet data

Sheet 1 is to be renamed ‘Original Data Super 6 pens’ and sheet 2 is to 
be renamed ‘Updated Data Super 6 pens’. Both new sheet names are to be 
coloured.

Data entry

Re-open your spreadsheet application, and then re-open the sheets you 
created in the previous two activities. Follow the steps.

Step 1  

Make sure your active sheet is Sheet 1. Double left click on the ‘Sheet 1’ 
tab in the bottom left hand corner. Over the words ‘Sheet 1’ enter Origi-
nal data Super 6 pens.

Step 2  

Move to Sheet 2. Double left click on the ‘Sheet 2’ tab in the bottom left 
hand corner. Over the words ‘Sheet 2’ enter ‘Updated data Super 6 pens’.

Step 3  

Return to ‘Original data super 6 pens’, right click and colour the tab. Re-
peat and use a different colour for the tab for ‘Updated data Super 6 pens’.

Step 4  

Check that your work matches Activity answer 5.
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Step 5  

Go into Print preview, then Setup, then Header/Footer, Custom header, 
and in the centre section type ‘Original data Super 6 pens’, then ‘OK’ twice. 
Check that the print preview matches Activity answer 5.

Step 6  

Print a copy of your ‘Original data Super 6 pens’ sheet, and include this in 
your portfolio.

Step 7  

Repeat these actions in respect to ‘Updated data Super 6 pens’, make 
sure you save your amendments, print a copy for your portfolio and then 
take a rest break.
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Practice

Practice activity 6

You now have to format your spreadsheet by merging cells, centring 
headings, expanding column widths and changing the page orientation.

Spreadsheet data

‘Updated Data Super 6 pens’ is to be formatted into a new sheet, renamed

‘Formatted updated data Super 6 pens’ and with the tab coloured. The 
heading, Super 6 pens is to be merged and centred.

Column A is to be expanded.

Both new sheet names are to be coloured.

Data entry

Re-open your spreadsheet application, and then open the sheets you 
created in the previous activities. Follow the steps below.

Step 1  

Open your ‘Updated data Super 6 pens sheet’, and then copy and paste it

into Sheet 3.

Rename Sheet 3 as ‘Formatted Super 6 pens sheet’.

Step 2  

We will now change some attributes in your sheet:

	➤ Go to cell A1, click and drag across to I1. In the Home tab and in the 
alignment section of the ribbon, click on ‘merge and centre’.

	➤ Then in B25 type the total net profit figure of 3197.12, then in A25 
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type ‘Total net profit Super 6 pens’ and press ‘Enter’.

	➤ You will see that all of the words in A25 are not visible in the cell (al-
though you can see them in the top right hand panel).

	➤ Whilst the active cell is A25, please go to Format Cells (right click), 
Alignment, click ‘Shrink to fit’ and ‘OK’. You will now be able to see all 
of the words in A25.

Then with your mouse, click on the junction of A and B, and move the 
cell divider to the right until you can see the words in A25 in normal size.

Column I is now located on page two of the sheet, and will appear on a 
separate page when printed!

Step 3  

You will need to make some changes to ensure that all of the figures ap-
pear on the same  page. We have a number of options:

	➤ Go to Print or Print preview, find the Page setup, and set orientation 
to Landscape.

	➤ Alternatively, you could go to Print or Print preview and ‘shrink’ to fit 
to one page. All components of the sheet will then print on the same  
page.

Step 4  

Check that your work is the same as Activity answer 6.

Step 5  

Print two copies using each of the methods above. Print one copy using 
landscape orientation and print another copy by shrinking and ‘fit to one 
page’ on portrait. Save your changes, include both printed sheets in your 
portfolio and take a rest break.



36 ICT Skills | Grade 11

Using  and testing of formulae to meet task requirements

It has been noted previously how important it is to enter data correctly. 
The same applies to entering formulae. Entering incorrect formulae will 
trigger an error response from the software or will produce incorrect re-
sults.

One way of checking the formula is to highlight the cell containing the 
formula and look at the panel under the toolbar. This will indicate exactly 
what formula is being used in that cell.

For more complicated formulae, you can use the ‘Trace precedents’ func-
tion in the formula auditing section of the Formulas tab. We will work 
through a simple exercise so you can see how this function works. It is a 
far more useful function when the worksheet is large and full of numbers 
with many formulae.

There are other methods of checking your formulae. Try ‘Error checking’ 
and ‘Show formulas’.
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Practice

Practice activity 7

Trace formulae to ensure accuracy.

Spreadsheet data

Create a new sheet.

Enter the following numbers in cells A1, B1, C1 and D1 – 235, 226, 273, 274.

Data entry

Open the spreadsheet file we have been working on and then follow the 
steps.

Step 1

When you opened your new workbook, this should have opened auto-
matically with three sheets. The first thing we are going to do here is to 
create a new sheet in your existing workbook:

	➤ Click on ‘Insert’ and then ‘Worksheet’.

	➤ Using your mouse and the left click function, and the small arrow 
which will appear above the pointer, drag the new sheet to the right 
of your ‘Formatted updated data super 6 pens’.

	➤ Then using the steps you followed in previous learning activities, re-
name that sheet ‘Checking formulae’ and colour code.

Step 2

Type the following data in your ‘Checking formulae’ sheet:
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	➤ in A1 insert the figure 235, in B1 226, in C1 273, in D1 274

	➤ in B3 insert the formula ‘=A1+B1+C1+D1’

	➤ in B5 insert the formula ‘=A1+B1+C1’.

	➤ in B7 use the comparison operator formula ‘=B3=B5’, to find out 
whether in fact B3 does equal B5.

Step 3

Then go to Formula, Formula auditing and activate ‘Show formula audit-
ing toolbar’.

	➤ Activate cell B3, and then on the toolbar click on ‘Trace precedents’. 
You can see that the program then links B3 with the four cells which 
provided data for the formula.

	➤ Then activate cell B5, and again click on ‘Trace precedents’. Again, 
the program links B5 with the three cells which provided data for the 
formula.

	➤ Then if you trace the precedents for cell B7, you will see that this is 
also linked.

	➤ Leaving the arrows as they appear, preview and then print this sheet, 
and include the printed sheet in your portfolio.



39Business

Practice

Practice activity 8

You are still employed by the stationery division of an organisation, and 
you have now been asked to prepare a spreadsheet for one of the other 
pen products sold by the division, the Slick 7.

The purpose of this spreadsheet is to enable the division to compare the 
net profit received from the sale of each line of pens – Super 6 and the 
Slick 7.

Spreadsheet data

	➤ In January, the division sold 9 pens in the first week, 8 in the second 
week, 13 in the third week, and 21 in the last week.

	➤ In February, the numbers were 20 in the first week, 28 in the second 
week, 8 in the third week, and 39 in the last week.

	➤ The numbers for March were 15, 16, 9, and 18; for April they were 19, 
17, 7, and 21; for May they were 10, 19, 10, and 12; and for June they 
were 13, 15, 18, and 31.

Data entry

Step 1

Open a new sheet in your existing workbook, and name the sheet ‘Data 
Slick 7 pens’.

Step 2

Include appropriate descriptors in all applicable columns and rows.
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Step 3

Enter the data above.

Step 4

Enter the necessary formulae to calculate the total pens sold in each 
month.

Step 5

Enter the necessary formula to calculate the total number of pens sold 
over the six months period.

Step 6

Enter the necessary formula to calculate the net profit for the total six 
months period where each pen sells for $14, and the cost of purchasing 
each pen is $6.

Step 7

Then enter the necessary formula to adjust the total net profit, taking 
into account handling costs of 1%.

Step 8

Apply shading to all cells which contain written descriptors.

Step 9

Include an appropriate header in your worksheet.

Step 10

Print your worksheet, including row and column headings but not grid-
lines, and include that worksheet in your portfolio.
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Step 11

Save your work and exit the spreadsheet application, and take a rest 
break before moving to the next section.

Use of manuals and online help

When you experience problems in working with spreadsheets, there are 
many ways in which you can get assistance.

The Help function in excel is very good. You can search under headings 
or you can use the search tool. See the offline Excel Help screen below.

You can also search online for assistance with Excel.

Comprehensive user manuals are also available. These provide a useful 
resource for users of spreadsheet applications.

Many employers will also provide employees with organisational proce-
dures, specific user documentation, style guides and presentation require-
ments.
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Practice

Practice activity 9

Using the online Help function, write a brief description of how to do the 
following.

How do you add or remove worksheet columns?

....................................................................................................................................................

....................................................................................................................................................

....................................................................................................................................................

How do you add headers and footers to worksheets?

....................................................................................................................................................

....................................................................................................................................................

....................................................................................................................................................

How do you change the number formatting?

....................................................................................................................................................

....................................................................................................................................................

....................................................................................................................................................

How do you save a workbook in another file format?

....................................................................................................................................................

....................................................................................................................................................

....................................................................................................................................................
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Produce simple charts
Selection of chart type to meet task requirements

Now that you have completed entering data into a spreadsheet you can 
now use that information to produce a simple chart.

Charts are used for many purposes.

One purpose is to demonstrate the data contained in a spreadsheet - or 
in some other document - in a more visual way in order to increase its im-
pact.

For example, if a colleague told you that in January this year his or her 
department sold 32 cars, but in each month since then the department 
had sold two cars less than the month before, or handed you a spreadsheet 
with the figures, you would hear the information, but it may not have a lot 
of impact. You might think, ‘Oh well, business is slowing down a little, that’s 
too bad’. However, if your colleague presented you with either of the fol-
lowing charts, you might view the information in a different way.

You can produce simple charts 
based on your spreadsheet data.
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Pie chart showing cars sold 

Bar chart showing cars sold

Bar chart showing quarterly results by region
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Charts can be presented in many different ways, and the type of chart 
will often depend upon the business or organisation and the targeted au-
dience. 

Let’s use our cars again as an example, and add the element of cars being 
returned because of defects. The chart could be presented as follows.

These are only some of the types of charts we can choose from, with 
some other selections being scatter, bubble, line, pie or 3D pie. 

In all cases, the type of chart will be dependent upon the nature of the 
business and the target audience. 

For example, some businesses or organisations might prefer very ‘se-
date’ types of charts, such as the first two charts we included; whilst others 
will prefer those which provide significant visual impact. Some audienc-
es might easily understand very complicated charts, whilst others will be-
come lost in the details if they are too complicated.

In Excel, go to the Insert tab and look at the different types of charts that 
are available. Click on the other charts icon to see other available chart de-
signs.

Three dimensional chart showing 
cars sold and defect returns

Bar chart showing cars sold and 
defect returns
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Practice

Practice activity 10

After viewing these charts, select three different types and in the follow-
ing table write down in what circumstances (types of presentation / indus-
try / audience) you think these could be used.

Type of chart Use of chart
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Creating and modifying charts
Charts are most commonly created within a spreadsheet based upon 

the spreadsheet data.

Depending upon the task requirements and how the work is prepared, 
this can result in information being provided in a manner which combines 
statistical information (spreadsheet data), with visual information (chart).

Practice

Practice activity 11

You now work at Hussain’s shop. Hussain wants to approach his local 
bank for a loan so that he can expand his business. At the moment, Hus-
sain sells computers, printers, and printer toner cartridges, and wants you 
to prepare a spreadsheet showing his sales figures for the past 12 months.

Hussain thinks that a chart will emphasise the point that his sales are 
steady and he instructs you to include a chart in the spreadsheet you are 
preparing based on his sales figures. Hussain does not specify what type of 
chart he wants.

Spreadsheet data

	➤ Computer sales for the 12 months (January – December):

	� 9, 4, 5, 9, 8, 11, 12, 13, 10, 7, 8, 11.

	➤ Printer sales for the 12 months (January – December):

	� 20, 15, 12, 11, 12, 13, 15, 17, 16, 17, 21, 22.

	➤ Toner sales for the 12 months (January – December):

	� 25, 12, 21, 19, 18, 19, 21, 23, 22, 26, 19, 20.
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Data entry

Work through the following steps to create the spreadsheet:

Step 1

Open a new workbook.

Step 2

In Sheet 1, enter the following data:

	➤ in column B insert the following figures in rows 2 – 13: 9, 4, 5, 9, 8, 11, 
12, 13, 10, 7, 8, 11

	➤ in column C insert the following figures in rows 2 – 13: 20, 15, 12, 11, 
12, 13, 15, 17, 16, 17, 21, 22

	➤ in column D insert the following figures in rows 2 – 13: 25, 12, 21, 19, 
18, 19, 21, 23, 22, 26, 19, 20

	➤ in B14 insert the calculation required to add all of the numbers in 
A2 – A13

	➤ in C14 insert the calculation required to add all of the numbers in 
B2 – B13

	➤ in D14 insert the calculation required to add all of the numbers in 
C2 – C13.

Step 3

Label A1 as ‘Sales’, B1 as ‘Computer sales’, C1 as ‘Printer sales’, and D1 as 
‘Toner sales’. Use your mouse to click at the top of each column and drag 
the right hand border so that all of the words in B1, C1 and D1 appear in 
full.
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Step 4

Commencing at A2, insert ‘Jan’, ‘Feb’ to ‘Dec’ down that row, and the word 
‘Totals’ in cell A14.

Step 5

Insert a blank row before the totals so that the totals now appear in row 15.

Step 6

Insert a header for the document by going to ‘View’ then ‘Header/Footer’, 
then to ‘Custom header’. In the centre section insert the words ‘Hussain’s 
shop’, increase the font to Arial 12, and underline these words.

Step 7

Rename that sheet ‘Hussain’s Shop Sales’.

Now we are ready to insert a chart.

In order for the program to prepare a chart based on the figures con-
tained in your spreadsheet, you have to instruct the program accordingly, 
and you can do this by highlighting cells A1 – D13 in your spreadsheet.

Work through the following steps to create your chart.

Step 1

Click on the Insert tab, select a ‘3-D column’ chart.

Step 2

The chart appears on screen in a text box. With your mouse, move the 
chart directly underneath the spreadsheet.

Step 3

Click the Layout tab and select ‘Chart title’ and then ‘Above chart’. In the 
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text box that appears, insert the words ‘Sales – January to December’ 
over the top of the words ‘Chart title’.

Step 4

Check to see that your work is the same as Activity answer 11.

Step 5

Save your work and print a copy to add to your portfolio.

Step 6

Repeat the process and experiment to see what other graphs look like.
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Practice

Practice activity 12

Hussain has reviewed the previous spreadsheet and chart you prepared.

Some figures are incorrect and need to be changed, and he would also 
like you to change the type of chart presentation to a 3D line chart.

Hussain does not want gridlines, or row and column headings shown in 
the printed spreadsheet.

He needs the updated spreadsheet and chart quite urgently, as he has 
an appointment with the bank manager tomorrow.

Assuming you saved your data and correctly exited the application in 
the previous activity, you will be able to retrieve your original spreadsheet 
data (and chart).

Spreadsheet data

	➤ Changes to computer sales:

	� October change from 7 to 11

	� November change from 8 to 12.

	➤ Changes to printer sales:

	� January change from 20 to 18

	� July change from 15 to 16

	� October change from 17 to 20.

	➤ Changes to toner sales:

	� November change from 19 to 22

	� December change from 20 to 24.
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Data entry

Work through the following steps to create the spreadsheet.

Step 1

Re-open your spreadsheet application, open your ‘Hussain’s Shop’ work-
book, and copy your spreadsheet data to Sheet 2.

Step 2

Rename Sheet 2 as ‘Hussain’s Shop Sales revised date’, and make the fol-
lowing data amendments:

B11 change 7 to 11, B12 change 8 to 12, C2 change 20 to 18, C8 change

15 to 16, C11 change 17 to 20, D12 change 19 to 22, D13 change 20 to 24.

Step 3

Prepare and include a 3D line chart in your spreadsheet based on the 
revised figures.

Step 4

Review your revised spreadsheet and chart, and ensure that gridlines 
and row and column headings will not be shown on printing, and ensure 
that the spreadsheet information and chart are neatly set out on page 1.

Step 5

Print a copy of your revised spreadsheet and chart for inclusion in your 
portfolio.

Step 6

Save your work and exit the spreadsheet application.
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Practice

Practice activity 13

Hussain failed to obtain his additional finance, and you are now working 
on a part-time basis. You are also again working for the stationery division 
of an organisation on a part-time basis. The manager of the stationery di-
vision is aware that you can prepare charts and has asked you to prepare 
some charts for the spreadsheets you have previously prepared.

Spreadsheet data

Spreadsheets for the Super 6 and the Slick 7 pens.

Data entry

Open your spreadsheet application, and return to the spreadsheets you 
previously prepared (‘Formatted updated data Super 6 pens’) and (‘data 
Slick 7 pens’), and then carry out the following.

Step 1

Copy the spreadsheets into a new workbook, into two sheets.

Step 2

The new workbook is to be saved and stored using the naming and stor-
ing conventions and is to be named ‘Super 6 and Slick 7 pen comparison’.

Step 3

Sheet 1 is to be used for the Super 6 pen data, and is to be renamed ‘Su-
per 6 pen data’; Sheet 2 is to be used for the Slick 7 pen data, and is to be 
renamed ‘Slick 7 pen data’.
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Step 4

Create a line chart with markers in each of the sheets, using the data in 
those sheets, labelling the charts appropriately.

Step 5

Copy each chart into Sheet 3, and rename that sheet ‘Comparison charts 
Super 6 and Slick 7 pens’.

Step 6

Insert an appropriate header in each of the three sheets.

Step 7

Using ‘Print preview’, implement the organisation’s requirements regard-
ing gridlines, and row and column headings in the ‘Super 6 pen data’ and 
‘Slick 7 pen data’ sheets.

Step 8

Print a copy of all three sheets for inclusion in your portfolio.

Step 9

Ensure your work has been saved, and then exit the application.

Step 10

Back up the ‘Super 6 and Slick 7 pen comparison’ workbook using a USB.
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Finalise spreadsheet
Preview, adjustment and printing

The last task you will need to complete as part of creating a simple 
spreadsheet is to finalise the work.

We have already considered adjusting data in a spreadsheet, and have 
worked through previewing spreadsheets.

We have also considered how the appearance of a chart can alter when 
the underpinning spreadsheet data changes, and also how we can select 
different types of charts which might be used in different situations and 
also, change their appearance.

There is no ‘right way’ to prepare spreadsheets or charts, as what is re-
quired will depend upon the particular task and organisational require-
ments.

Always preview (print preview) and adjust the spreadsheet prior to print-
ing a hard copy. Because the columns and rows are almost endless, it is very 
easy with spreadsheets to waste papers. After amending the spreadsheet, 
preview to ensure it has not moved over to the next page.

When finalising your work you may need to preview, adjust or 
print your spreadsheet – Remember, you will always need to 

meet deadlines and manage your files correctly
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Designated timelines
A designated timeline might include an organisational timeline where, 

for example, information might be required for presentation to a company 
the auditor, an external customer or client may require the organisation to 
produce a spreadsheet or a chart within a certain time, that is to assist in a 
presentation to the customer’s employees, or it may simply be a timeline 
set by a supervisor.

If a timeline is set, then of course it must be met; and for this purpose, 
your teacher may allocate a designated timeline to any of your activities or 
assessment tasks.

NOTES

Page 15

NOTES

Page 16

Nicenotes

An example of a diary which may be used to write down your 
timelines for your activities or assessment tasks
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Storing spreadsheets
After all the work is done, it is very important to ensure the spreadsheet 

is saved and stored correctly. We have already considered organisational 
requirements as to file and folder naming protocols. You should be follow-
ing school protocols to save your work in the appropriate location.

Passwords on the school computers will ensure unauthorised access to 
your account will not take place. It is important that you do not share your 
passwords with anyone else.

How often do you back up your files, especially those that you may use 
between school and home? Think about what information would be lost if 
all your files were corrupted. Your files at school will be backed up regularly.

However, you should ensure your personal files are backed up frequent-
ly. USBs are often used for this purpose.

Organisational policy and procedures will ensure that business data is 
protected. Always carefully follow instructions that relate to back up of files.

Methods of storage include CD ROM, zip drives, external hard drives and 
USBs.
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Practice activity answers
The practice activity answers section is provided for you to self check 

your responses to the practice activities contained within this Learner Re-
source. In some instances you will notice that sample or typical answers 
may be given, these answers are only what might typically be expected as 
an answer. In these instances, if you cannot relate the answer given to your 
response you should contact your facilitator to discuss your responses.

Practice

Activity answer 1
	� Recycling paper.

	� Turning off lights when you leave the room.

	� Turning off electrical equipment at the end of the day.

	� Utilising sleep modes on equipment.

	� Flash drives to store data electronically rather than print hard copies.

	� Use email to send documents rather than print hard copies.

Practice

Activity answer 2
	� The active cell is C5.

	� The name of the worksheet is ‘Blank’.
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Practice

Activity answer 3
Spreadsheet should be completed as per the following.
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Practice

Activity answer 4
Spreadsheet should be completed as per the following.
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Practice

Activity answer 5
Spreadsheet should be completed as per the following.
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Practice

Activity answer 6
Spreadsheet should be completed as per the following.
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Practice

Activity answer 7
Spreadsheet should be completed as per the following.
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Practice

Activity answer 8
Spreadsheet should be completed as per the following.
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Practice

Activity answer 9
1.	 	Select the columns to be deleted. Go to the ‘Home’ tab and in the 

‘Cells’ group click delete.

2.	 Click on the worksheet. Go to the ‘Insert’ tab and in the ‘Text Group’ 
click on Header/Footer.

3.	 Click on the cell or range of cells to be formatted and go to the ‘Cells’ 
tab and click on format.

4.	Click ‘Save As’ and in the ‘Save As’ type click the type of file you want 
to save.

Practice

Activity answer 10

Pie graph
Show a break up of different selling expenses

Show a break up of services by type

Line graph
Show the net profit figure month by month

Show the weekly payroll figure

Bar graph
Show departmental expenses

Show the number of employees by department



66 ICT Skills | Grade 11

Practice

Activity answer 11
Spreadsheet should be completed as per the following.
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Practice

Activity answer 12
Spreadsheet should be completed as per the following.
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Practice

Activity answer 13
Spreadsheet should be completed as per the following.

ICT Skills Business
Activities
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ICT Skills Business
Activities
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Activity 1

You are required to establish a folder for the purpose of saving all of the 
work you do in this subject.

Create a folder called ‘Spreadsheets’.
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Activity 2

In sheet 1 Type the following spreadsheet and format it to look like the 
example below. 

Task requirements 

1.	 Type in all text and numbers shown in the spreadsheet below. 

2.	 Center the spreadsheet headings above each column. 

3.	 Format all text and numbers as displayed in the example below. 

4.	Click on cell B4 and write down the contents of this cell.

5.	 Click on cell E5 and write down the contents of this cell.

6.	Save your work again and exit the program correctly.

A B C D E F
1
2 Products Sunday Monday Tuesday Wednesday Thursday
3 Software 2,455 3,584 2,793 2,705 3,621
4 Hardware 4,581 5,141 5,842 6,745 4,873
5 Stationery 1,404 1,864 1,739 1,557 1,815
6
7
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Activity 3

Type the following spreadsheet and format it to look like the example 
below. 

Task requirements 

1.	 Type in all text and numbers shown in the spreadsheet below. 

2.	 Format all text and numbers as displayed in the example below. 

3.	 Select the range of cells ‘B2:F2’, and go to the Alignment tab and click 
on the center alignment icon.

4.	Everything in column A is to be in bold.

5.	 Use sum to calculate total 

6.	Change format to row ( 10 )

A B C D E F
1 Sales of 2019
2 Jan Feb Mar Apr May June
3 Cost of sales 85,658 74,281 48,524 65,048 75,931 84,482
4 Insurance 29,412 22,843 18,632 21,795 24,802 28,058
5 Gross Profit 11,715 10,627 12,924 11,715 10,584 12,924
6 Selling Expenses 15,651 15,843 14,739 16,882 14,927 17,455
7 Admin Expenses 10,584 12,924 11,715 10,627 12,804 11,193
8 Finance Expenses 5,200 5,200 5,850 5,200 5,200 5,850
9

10 Total



73Business

Activity 4

Type the following spreadsheet, and format it to look like the example 
below. 

Instructions 

	➤ Type in all text and numbers shown in the spreadsheet below. 

	➤ Use an appropriate format for all numbers. 

	➤ Center the spreadsheet heading ‘Travel Expenses for the Month of 
May’ across the spreadsheet. 

	➤ Format all text as displayed in the example including the rotated 
text labels. 

	➤ Apply all borders and shading (color) shown in the example.  

	➤ Calculate the total ( use sum ).
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Activity 5

1.	 Create a new worksheet and use these fields  

Name Arabic Islamic English computer accounting spread sheet MATH Total

Ismael 40 35 45 40 35 40 45

Mohamad 41 48 29 41 48 41 29

Osama 33 46 41 33 46 33 41

AHMED 25 24 33 25 24 25 33

Nasr 41 28 43 41 28 41 43

Waleed 35 39 46 35 39 35 46

Abdo 28 47 28 47 47 28 28

Assem 39 26 36 26 26 39 36

Yasser 48 47 48 47 47 48 48

2.	 sort ( name) filter   A to Z

3.	 format all numbers (Arial font – size 15 )

4.	in the header  ( insert your name ) in footer ( class )

5.	 Find and replace

a.	 Nasser instead of  Nasr. 

b.	 Essam instead of Assem 

6.	insert chart for all students
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Activity 6

1.	 Insert 2 online pictures  in workbook and use options:

a.	 Change Picture style.

b.	 Use Picture border.

c.	 Use Picture effect. 

d.	 Use crop tool .

e.	 Grouping two images .

f.	 Arrange pictures.

g.	 Change pictures size .

2.	 Insert smart art graphic:

3.	 Add shape (Rectangle), put (circle) inside it  , insert word art.

4.	Use the screen shoot tool

Principal

Academic
Deputy

 Principal

Administrative
Deputy

 Principal

Social
WorkerNurse Teachers



76 ICT Skills | Grade 11

Activity 7

1.	 Use manual formulas : 

  Calculate the sum , max , min , aver  

2.	 Use increase two decimal

3.	 Add currency $ for numbers of sales 

4.	Add header (your name ) and footer ( class )

5.	 Format heading font ( Tahoma) and size 18

6.	Format subheading font ( Calibri ) and size 14 

Qatar tech company 

Products Sunday Monday Tuesday Wednesday Thursday Total max

Software 2,455 3,584 2,793 2,705 3,621
Hardware 4,581 5,141 5,842 6,745 4,873
Stationery 1,404 1,864 1,739 1,557 1,815
Books 5,141 5,842 1,404 6,745 2,793
DVD 2,793 6,745 5,842 1,404 6,745
CD 6,745 5,842 1,404 2,793 5,842

Total sales
Min

Average 

Max
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Activity 8

1.	 Calculate the sum , max , min , aver  

2.	 Use increase two decimal

3.	 Change currency to $ for numbers of sales 

4.	Add header (your name ) and footer ( class )

5.	 Format heading font ( Arial) and size 18

6.	Format subheading font ( times new roman ) and size 14 

Item Saturday Sunday Monday Tuesday Wednesday Thursday Friday AVERAGE Maximum Minimum

DELL LAPTOPS 10,000€       8,000€       5,000€          9,000€          7,000€         15,000€       7,000€       

LENOVO DESKTOPS 15,000€       7,000€       4,000€          10,000€        5,000€         12,000€       8,000€       

SAMSUNG TABLETS 5,000€         6,000€       2,000€          8,000€          8,000€         10,000€       7,000€       

I PHONE MOBILES 5,657€         7,789€       3,650€          9,832€          9,856€         9,282€         7,643€       

SAMSUNG MOBILES 8,443€         7,569€       8,933€          2,342€          5,632€         2,135€         6,546€       

TOTAL

Weekly sales report

QBS COMPUTER COMPANY
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Activity 9

1.	 use manual formulas : 

Calculate the sum , max , min , aver   

2.	 add one decimal FOR ALL numbers 

3.	 add currency  $  for numbers of sales 

4.	add header ( name ) and footer (Last name + class )

5.	 heading font ( Tahoma) and size 16

6.	subheading font ( Calibri ) and size 12 

Sales  2020 Jan Feb Mar Apr May Average total max
Current year Expenses 85,658 74,281 48,524 65,048 75,931
Cost of sales 29,412 22,843 18,632 21,795 24,802
Selling Expenses 15,651 15,843 14,739 16,882 14,927
Admin Expenses 10,584 12,924 11,715 10,627 12,804
Finance Expenses 5,200 5,200 5,850 5,200 5,200

Total for every month
Average
MAX
Min
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Activity 10

Tick the requirements that apply to the preparation of this task.

Task requirements:

1.	 Create a new Excel sheet called (Net salary )

2.	 Enter the following data into Excel sheet.(next page)

3.	 Change page orientation to landscape for your spreadsheet.

4.	Write your name in the header for this spreadsheet.

5.	 Write your Grade/class in the footer for this spreadsheet.

6.	The heading is to be in Arial 18pt, bold, merged and centered above 
the columns used.
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7.	 The column headings are to be Arial 14pt and bold.  The wrap text 
formatting function should be used for column headings.

8.	The remaining table is to be Arial 12pt and bold.

9.	All numbers should be in $, show two decimals and the thousand sep-
arator.

10.	Change the color for heading and column headings.

11.	Sort the table according to the salary column from (smallest to largest)

12.	Calculate the salary tax column(salary *20%)

13.	Calculate the salary bonus column (salary *5%)

14.	Calculate the Net salary column. (salary-salary tax+ salary bonus)

15.	Use conditional formatting to show the net salary greater than 1500 $ 
with green color. 
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Activity 11

Qatar football Association

Total Income Operating Expenses Profit before tax Tax Profit after tax

Ahli 335,55 145,211
Al Arabi 540,916 520,754
Al saad 321,725 198,340
Al gharafa 785,841 385,964
Lekhwia 328,922 65,485
Total 
Average 

1.	 Insert a formula to calculate the Profit before tax for each branch

                                                               (Total income – Operating expenses).

2.	 Insert a formula to calculate the Tax for each branch = 10%       (Profit 
before tax * 10%).

3.	 Insert a formula to calculate the Profit after tax for each branch. (Prof-
it before tax - Tax).

4.	Change all number to currency ( Qar ) 

5.	 Insert header ( name ) and in footer ( class

6.	Using “ help” by pressing  F1

	�  Search for “  header and footer  “ .

	� copy result text .

	�Create a new document word , paste above results  
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Activity 12

1.	 create a new worksheet and use this fields

2.	 use appropriate formula 

3.	 change number to $ currency 

Products Sunday Monday Tuesday Wednesday Thursday total

Software  $         2,455  $     3,584  $         2,793  $        2,705  $        3,621 

Hardware  $         4,581  $     5,141  $         5,842  $        6,745  $        4,873 

Stationery  $         1,404  $     1,864  $         1,739  $        1,557  $        1,815 

Books  $         5,141  $     5,842  $         1,404  $        6,745  $        2,793 

DVD  $         2,793  $     6,745  $         5,842  $        1,404  $        6,745 

CD  $         6,745  $     5,842  $         1,404  $        2,793  $        5,842 

Average          

SOFT+HARD  

BOOK+ 

Stationery
 

CD+DVD  
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Activity 13

1.	 Entering data in the following table :                                                        

Name sales Hourly worked Reward

Ahmad 30000 120  

Assem 50000 150  

Ismail 80000 160  

Mohamad 20000 80  

Hamad 60000 155  

Waleed 50000 150  

Yasser 90000 185  

2.	 Use IF  to calculate the reward for employees  (REWARD = 150 HOURS)

NAME Arabic English Islamic computer accounting OHS Math TOTAL Excellent/
good

Ahmad 27 38 33 27 22 27 22

Ali 19 45 38 21 29 36 44

Jassem 44 19 26 44 26 44 26

Khalid 29 29 24 27 27 29 27

Muhammad 25 27 26 25 26 21 19

jaber 29 18 38 27 38 43 38

Waleed 21 21 42 18 33 33 42

NaÏf 37 39 22 18 24 21 21

3.	 Use IF  to know who of the students are Excellent 

	� Excellent = (over 200 )

	�Good = (under 200 )
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Activity 14

Prepare the following spreadsheet. Observe the organizational instruc-
tions below:

1.	 The heading is to be in Arial 24pt, bold, merged and centered above 
the columns used.

2.	 The column headings are to be Arial 16pt and bold.  

3.	 The remaining table are to be Arial 12pt and bold.

4.	Sort the students’ Names from A-Z.

5.	 Use the Sum formula to find the total column.

6.	Find the TOTAL column and format without decimals.

7.	 Use IF function to choose ( pass > 75  ) or fail for each students.

Student’s Name Test 1 Test 2 Test 3 Test4 Total Result

ALI 16 13 9 22    

OMAR 14 4 8 23    

AHMAD 17 18 8 33    

MOHAMMAD 17 19 12 34    

FAHAD 15 16 9 29    

RASHID 14 16 11 35    

JABIR 13 14 9 36    

JASSIM 18 16 9 38    

OMRAN 5 5 10 32    

YOUSIF 19 19 8 31    
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Activity 15

Prepare the following spreadsheet.  Observe the organizational instruc-
tions below:

8.	The heading is to be in Arial 22pt, bold, merged and centered above 
the columns used.

9.	The column headings are to be Arial 14pt and bold.  

10.	The remaining tables are to be Arial 12pt and bold.

11.	Sort the students’ Names from A-Z.

12.	Use the Sum formula to find the total column.

13.	Use IF function to choose employee who took ICT course  .

( employee who took ICT course  = 215 $  for total sales)

QBS TECHNLOGY (SALES)

Name SEP OCT NOV DEC Total ICT COURSE

ALI  $         50.04  $         23.90  $           66.50  $         48.74    
NAIF  $         68.69  $         78.20  $           19.80  $         53.29    
KHLIFA  $         48.74  $         62.21  $           50.04  $         67.30    
FAHAD  $         53.29  $         25.47  $           68.69  $         56.90    
SAEED  $         38.50  $         34.60  $           48.74  $         68.69    
JASSIM  $         66.50  $         78.20  $           53.29  $         48.74    
MOHAMMAD  $         19.80  $         48.74  $           38.50  $         53.29    
FAISAL  $         13.47  $         25.47  $           23.90  $         38.50    
NAWAF  $         57.62  $         38.50  $           78.20  $         66.50    
HAMAD  $         10.14  $         18.70  $           62.21  $         19.80    
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Activity 16

1.	 Create a Drop Down list for all subjects?

Name  ARABIC ENGLISH ISLAMIC COMPUTER MATH SPREADSHEET ACCOUNTING

Ahmad 36 47 36 35 47 35 47

jassim 40 35 45 40 35 40 35

ismail 35 49 37 39 39 44 49

Mohamad 36 41 36 35 46 49 41

Naif 37 48 39 35 47 48 48

walid 37 46 44 45 48 44 46

Saoud 35 47 38 38 41 43 47

A 50-45
B 45-40
C 40-35

2.	 Use conditional formatting to highlight cells 

A = GREEN

B=BLUE

C=RED
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Activity 17

1.	 Create a Drop Down list 

2.	 USE COUNT IF 

NAME SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY
Ahmed حاضر حاضر حاضر غائب غائب

Ali          
Aziz          
Ismail          
Mohamed          
Jassim          
Waleed          
Nawaf          

أيام الحضور أيام الغياب
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Activity 18

Use formula ( count if ) and ( sum if  )

Employees salary sheet

Employee name Department Status Hiring  date Salary

Rashid sales
full 

time
2015/9/2  $         20,000 

Fahad marketing
full 

time
2016/12/1  $         60,000 

Naif accounting
full 

time
2014/8/1  $         30,000 

Mohammad accounting
half 

time
2010/5/1  $           35,000 

Ali marketing
half 

time
2009/3/1  $          50,000 

Omar sales
full 

time
2009/3/1  $          40,000 

How many employees working as full time?   count if

How many employees working at sales department?   count if

How many employees got salaries more than 35,000?   count if

How much is the  total of salaries  that are greater than 30,000?   sum if

How much is the total of salaries  for the employees working as full time?   sum if
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Activity 19

The students in 11 C have received the following grades for their Octo-
ber Report.  

Name English Math Arabic Science
Yasser 54 76 66 54
Mohamad 88 90 76 72
Jassim 74 78 44 36
Waleed 88 38 52 88
Nasr 58 78 68 54
Rashid 50 84 59 52
Ali 58 36 76 54
Ahmad 55 72 84 66

You are required to:

1.	 Create a new worksheet called “chart 1” 

2.	 Sort the students into alphabetical order (A – Z)

3.	 Create a bar chart and display all data labels for all students.

4.	Insert a chart title ( October Report) .

5.	 Insert a pie chart for (Ali) only

6.	Insert appropriate axis titles.

7.	 Move legend to bottom 

8.	Fill the chart with blue color and make the border brown in 3 pt.
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Activity 20

1.	 Design the following table and enter the data for each product  

Products Sunday Monday Tuesday Wednesday Thursday

LAPTOP 2,455 3,584 2,793 2,705 3,621

I PAD 4,581 5,141 5,842 6,745 4,873

TAB 1,404 1,864 1,739 1,557 1,815

NOTE 5,141 5,842 1,404 6,745 2,793

MOBILE 2,793 6,745 5,842 1,404 6,745

2.	 Insert chart ( bar & column ) to the above table .

3.	 Add charts pie for items ( Tab – Note ) .

4.	Add title to chart (sales first week ) .

5.	 Add Axis to above chart.

6.	Add legend to above chart.

7.	 Add gridlines to chart .
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Activity 21

1.	 Design the following table and enter data for each Item  

  Brands Marks Splash Max Bhs H&M

shirt QAR 33.00 QAR 30.00 QAR 34.00 QAR 22.00 QAR 81.00 QAR 155.00

t-shirt QAR 52.00 QAR 55.00 QAR 60.00 QAR 54.00 QAR 59.00 QAR 62.00

Suit QAR 450.00 QAR 543.00 QAR 512.00 QAR 580.00 QAR 560.00 QAR 540.00

Sport suit QAR 252.00 QAR 260.00 QAR 230.00 QAR 280.00 QAR 240.00 QAR 255.00

dress QAR 288.00 QAR 312.00 QAR 319.00 QAR 322.00 QAR 344.00 QAR 328.00

Trousers QAR 150.00 QAR 161.00 QAR 168.00 QAR 165.00 QAR 163.00 QAR 164.00

2.	 Insert chart (column) to above table .

3.	 Move chart to another sheet.

4.	Change design and format of chart.

5.	 Add data table to above chart.

6.	Add data label to chart

7.	 add legend below chart .
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Activity 22

1.	 How to calculate all staff age By using Excel Formulas?

last name first name position birthday age ICT Course 

Ali Hamad Salesman 14/Apr/1977

Hassan Rashid Marketing Actor 10/May/1979

Ahmed Majid Customer Service 12/Nov/1988

Fahad Said Help Desk 5/Oct/1974

Jassim Waleed Marketing Actor 14/Oct/1996

Naser Tamim Salesman 17/May/1999

Jassim Abdulrhman Advertising 14/Jun/1997

Ibrahim Omer Help Desk 18/Oct/1998

Nawaf Ahmed Marketing Actor 4/Sep/1975

2.	 use conditional formatting to highlight age greater than 40 ( green )

3.	 use if statement to identify employee have ict course  
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Activity 23

1.	 Design the following table :

Item Al-Noor AL- Forsan AL- Shams Al- Jassim Al- Sharq Al- Mohandas

desk QAR 36.00 QAR 33.00 QAR 35.00 QAR 24.00 QAR 88.00 QAR 160.00

chair QAR 50.00 QAR 55.00 QAR 60.00 QAR 54.00 QAR 59.00 QAR 62.00

table QAR 500.00 QAR 543.00 QAR 512.00 QAR 580.00 QAR 560.00 QAR 540.00

comp-desk QAR 250.00 QAR 260.00 QAR 230.00 QAR 280.00 QAR 240.00 QAR 255.00

cupboard QAR 300.00 QAR 312.00 QAR 319.00 QAR 322.00 QAR 344.00 QAR 328.00

case QAR 160.00 QAR 161.00 QAR 168.00 QAR 165.00 QAR 163.00 QAR 164.00

2.	 Freeze pane ( top row ) 

3.	 Freeze pane ( first column ) 

4.	Use hyperlink for all items 
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